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    Chapter 3   

 Physiological Analysis of Phototropic Responses 
in  Arabidopsis                      

     Mathias     Zeidler      

  Abstract 

   Plants utilize light as sole energy source. To maximize light capture they are able to detect the light 
direction and orient themselves towards the light source. This phototropic response is mediated by the 
plant blue light photoreceptors phototropin1 and 2 (phot1 and phot2). Although fully differentiated 
plants also exhibit this response it can be best observed in etiolated seedlings. Differences in light between 
the illuminated and shaded site of a seedling stem lead to changes in the auxin-distribution, resulting 
in cell elongation on the shaded site. Since phototropism connects light perception, signaling, and auxin 
transport, it is of great interest to analyze this response with a fast and simple method. 

 Here we describe a method to analyze the phototropic response of  Arabidopsis  seedlings. With numer-
ous mutants available, its fast germination and its small size  Arabidopsis  is well suited for this analysis. 
Different genotypes can be simultaneously probed in less than a week.  
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1      Introduction 

 The fi rst scientifi c observations of phototropic plant responses date 
back to the sixteenth century (reviewed in Ref. [ 1 ]). Darwin dis-
covered that the perception of the stimulus and the site of action 
could be separated [ 2 ] which later led to the discovery of Auxin 
[ 3 – 5 ]. The responsible photoreceptors were identifi ed with the 
help of molecular-genetics in the model plant   Arabidopsis      thaliana    
and later named after their major response:  PHOTOTROPINS   
(phot) [ 6 ,  7 ].  Arabidopsis  has two phots (phot1 and phot2) which 
are also involved in the regulation of  chloroplast movement   and 
stomatal opening. They are light-activated kinases. A sensory part 
with two LOV (light, oxygen, voltage) domains inactivates the 
kinase domain in the dark. After activation the sensory domain 
releases the kinase domain and phots can phosphorylate target pro-
teins [ 8 ]. Phot1 regulates the phototropic response to a wide range 
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of blue light intensities while phot2 mainly mediates the response 
to high-intensity blue light [ 9 ]. 

 Other photoreceptors modulate phot mediated phototropism, 
mainly the blue light sensing CRYPTOCHROMEs (cry1 and 
cry2; [ 10 ]) as well as the red light sensing phytochromes, especially 
PHYTOCHROME A (phyA) [ 11 – 14 ]. While crys and phyA 
appear to enhance the phototropic response to blue light, crypto-
chromes also seem to be responsible for residual phototropism in 
the  phot1phot2  double mutant [ 15 ]. Additionally phyA has been 
shown to mediate the enhancement of phototropism by a red 
light pretreatment [ 11 ,  16 ,  17 ]. Consequently a  cry1cry2phyA  
triple mutant has a severely disturbed phototropic response [ 18 ]. 
Signaling factors for phototropism downstream of the phots 
have also been identifi ed, among them NONPHOTOTROPIC 
HYPOCOTYL 3 (NPH3), ROOT PHOTOTROPISM 2 (RPT2) 
[ 19 ,  20 ], and the PHYTOCHROME KINASE SUBSTRATE 
(PKS) family with four members (PKS1–4). PKS1, PKS2, and 
PKS4 are associated with the plasma membrane and interact with 
phot1, phot2, and NPH3 [ 21 – 23 ]. PKS1, 2, and 4 as well as 
NPH3 have been shown to infl uence  auxin   distribution and auxin- 
dependent   gene expression [ 24 ,  25 ]. Further downstream auxin 
transport facilitators are involved in phototropism. Among them 
are the PIN-FORMEDs (PINs),  ATP-binding-cassette B-type 
transporter (ABCB)  , and the AUXIN RESISTANT (AUX) 1—
LIKE-AUX (LAX) family proteins [ 26 – 31 ]. 

 Many different techniques have been described to analyze 
phototropism in   Arabidopsis    seedlings from which the growth on 
vertical oriented agar plates is the most common and easiest, and 
therefore this technique is described here. Others, like continuous 
video documentation of the seedlings [ 32 ] or microbeam irradia-
tion on single seedlings [ 33 ] have also been used successfully to 
measure hypocotyl bending in unilateral illumination conditions. 
They require a more sophisticated setup and data management but 
deliver time resolved information. Nevertheless, for the routine 
test of few lines the technique described here is easy and requires 
no specifi c instruments or software. Results can be obtained in less 
than a week.  

2    Materials 

     1.    20–40  Arabidopsis   seeds per line you want to investigate.   
   2.    ½ MS solid medium: 2.15 g/l MS (Murashige–Skoog salts, 

without vitamins;  see   Note 1 ) in H 2 O (Milli-Q). Adjust pH to 
5.7 with KOH, add 0.7 % agar, and autoclave. Pour in sterile 
square petri dishes (12.5 × 12.5 × 1.5 cm).   

Mathias Zeidler



23

   3.    Sterilization solution: 2.5 % (v/v) sodium hypochlorite in H 2 O 
(Milli-Q) with 0.1 % (v/v) Triton X-100. Prepare fresh and be 
careful because the solution is quite corrosive.   

   4.    Plating Solution: 0.1 % agarose ( see   Note 2 ) in H 2 O (Milli-Q), 
autoclaved.   

   5.    A narrow band width light source (full width at half height; 
FWHH < 30 nm) with the option to adjust different fl uence 
rates is necessary. Usually a slide projector with an interference 
fi lter can be used. Much better are high power LEDs that 
are easily available. For unilateral blue light we use 450 nm 
Luxeon high power LEDs (Roithner Lasertechnik, Austria), 
which are mounted on a 2-mm thick aluminum plate for cool-
ing and connected to a power supply. Fluence rates between 1 
and 100 μmol m −2  s −1  can be easily obtained by changing the 
current, and for lower fl uence rates semitransparent paper is 
brought into the light path.   

   6.    Black paper.   
   7.    Book stands or black wooden boxes in which up to 6 square 

petri dishes will fi t (inner dimensions 10 × 13 × 13 cm one side 
open).   

   8.    Computer with the ImageJ software (National Institutes of 
Health) installed.      

3    Methods 

       1.    You will need 1–2 petri dishes per genetic line to investigate. 
Take the plates with the solidifi ed media, turn them bottom-
up and draw a line on the bottom of the petri dishes. The start 
point should be 5 mm before the top-midpoint of the plate 
and the end point 5 mm after the bottom midpoint of the plate 
if it lies on a table in front of you (Fig.  1a ;  see   Note 3 ). Turn 
the plates back to the normal position (bottom-down).

       2.    Sterilize the seeds by mixing them with 500 μl of sterilization 
solution in 1.5-ml reaction tubes and let the suspension incu-
bate for 10 min at room temperature ( see   Note 4 ). Centrifuge 
briefl y. From this point onwards work on a sterile bench. 
Discard the sterilization solution quickly and wash the seeds 
three times with 1 ml of sterile water. After the last wash, dis-
card the water, add 100 μl of 0.1 % agarose, and mix.   

   3.    Pipette some of the seeds in 0.1 % agarose on the drawn line 
on the MS medium (Fig.  1a ). Move the single seeds with a 
sterile inoculation loop. Make sure that the distance between 
each seed is approximately 3–5 mm ( see   Note 5 ). Let the sur-
face of the medium dry briefl y on the clean bench so that the 
seeds do not shift when the plates are placed in the vertical 

3.1  Seed Preparation
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position. Close the petri dishes and label them on the bottom 
with the genotype of the seeds they contain.   

   4.    Stratify your seeds for 3–4 days wrapped in aluminum foil at 
4 °C, already in the vertical position. Mark the top side of the 
plates.      

       1.    Unwrap the plates and expose 2 h to white light to synchro-
nize germination.   

   2.    Place the plates back in standing position and insert a black 
paper between each separate plate to minimize refl ection. Also 
put a black paper at the back of the plate stack.   

   3.    The plates should now be in a stack in which all the plates are 
standing, with black paper on both sides of the plates and on 
the back of the cube-like stack (Fig.  1b ;  see   Note 6 ).   

   4.    Let seeds germinate and the emerging seedlings grow nega-
tively gravitropically for 2–3 days in darkness at 20–25 
°C. Ideally, the plates should already be in front of the irradia-
tion setup. The irradiation setup and position of the plate stack 
should be prepared in a dark room or in a completely dark 
cabinet.   

   5.    After the germination and negative gravitropic growth, switch 
the light on to irradiate the seedlings from one side with blue 
light of the desired fl uence rate for 12 h ( see   Note 7 ). The 
plates should be slightly moved out of the direct straight line 

3.2  Germination 
and Illumination

  Fig. 1    Schematic drawings of plate layout and light path to the plate stack. ( a ) View of open plate with the line 
on the bottom slightly rotated in relation to the center of the plate. Seeds are separately arranged on this 
line with a distance of 3–5 mm each. ( b ) Plate is closed and placed vertically so that the TOP (see also  a ) is on 
the upper side. Plates are stacked with black paper in between them as well as on the outside and on the back 
of the stack. The stack is slightly turned so that the light falls with a 0.5–1° angle on the agar surface       
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of the light path so that the light falls obliquely onto the agar 
surface (Fig.  1b ). Depending on the light source, different 
fl uence rates can be adjusted in the light fi eld by shading the 
front side of the petri dish cubes with semitransparent paper.   

   6.    Document the phototropic bending angle by digital photogra-
phy. Place a piece of millimeter paper next to the seedlings to 
obtain a scale.      

       1.    Install ImageJ from http://rsb.info.nih.gov/ij/ and start the 
program.   

   2.    Open your image: File>Open.   
   3.    Make sure the plate is aligned with the border of the window: 

Image>Transform>Rotate.   
   4.    Change the image to 8-bit greyscale: Image>Type> 8-bit.   
   5.    Click on the angle-measuring button in the tools menu.   
   6.    Click once on the base of the hypocotyl, once on the midpoint 

of the bend and last on the upper part of the hypocotyl.   
   7.    Press M on the keyboard to save the measurement in the results 

windows.   
   8.    Go back to  step 6 .   
   9.    When fi nished with one biological sample, copy the data to 

Excel or a similar program to plot the angles ( see   Note 8 ).       

4    Notes 

     1.    Adjust the amount of MS salts according to the recommenda-
tions of the supplier. The number here refers to MS-salts from 
Genaxxon (Germany).   

   2.    Agarose is used here and not agar. The low concentration aga-
rose has a similar density as the seeds and allows them to fl oat. 
This makes pipetting and manipulating the seeds much easier.   

   3.    A slightly slanted line is intended so that the seedlings do not 
disturb each other when growing negatively gravitropically.   

   4.    It is important not to exceed these 10 min because then the 
seeds suffer damage and germination rates drop. On the other 
hand, a much shorter time does not sterilize the surface suffi -
ciently. Therefore 10 min should be observed closely (+/− 1 min).   

   5.    This may be diffi cult at the beginning because the seeds tend 
to stick to each other in the drops of liquid. Therefore, less 
liquid is better. Try fi rst to position a few seeds and when you 
are done, take more out of the tube onto the agar surface.   

   6.    Care should be taken that the plates are exactly upright. This 
can be achieved by constructing wooden boxes or by using 
bookstands on both sides of the upright stack.   

3.3  Measuring 
the Bending Angle 
with ImageJ
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   7.    For standard tests a fl uence rate of 1 μmol m −2  s −1  should result 
in a good response of the wild type. Fluence rates should be 
determined with a PAR meter or similar device at the point 
where the seedlings will be positioned.   

   8.    Usually it is not conclusive to take a mean value of the angles, 
especially if plants are not behaving normally (for instance 
showing a positive or negative reaction towards the light 
source). It therefore is better to take classes of angles (0–10°, 
11–20° etc.) and sort all the measured values into these classes, 
so that a table is generated which comprises numbers of seed-
lings per class. This table needs to be normalized to the 
number of seedlings by translating the numbers per class to 
percentage of all seedlings per class. This dataset contains more 
information than the mean (Fig.  2 ).

  Fig. 2    Different presentations of the same bending angle data. Three artifi cial data sets, representing a normal 
distribution, a wide distribution, and an avoidance component in the bending response were plotted with three 
different methods. ( a ) An average does not differentiate between  mutant1  and  mutant2  (positive and negative 
phototropism) nor does it refl ect the avoidance reaction.  Error bars  represent standard errors of the mean. 
( b ) All seedlings were sorted into classes and normalized to the total amount of seedlings from each genotype. 
This is a much better representation of the response and the differences between the different genotypes. 
In ( c ) the same data were converted into circular histograms ( wuschel -diagrams). Here the length of a line 
represents the percentage of seedlings in this specifi c angle class. This diagram, also based on the same data 
set as in  b , is more informative. The light was coming from the right hand side as indicated by the  arrow  and 
the scale bar is 10 % of the seedlings represented       
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